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ARM/Thumb Interworking
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Outline

• About ARM/Thumb Interworking

• ARM/Thumb Interworking Example
– ARM/Thumb Interworking in C/C++

– ARM/Thumb Interworking Example in ASM

– ARM/Thumb Interworking Example between ARM &
C/C++

• LAB Exercise
– Part A

– Part B

– Part C

• Reference Topics & Related Documents
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About ARM/Thumb Interworking

• What is ARM/Thumb Interworking?
– An application is allowed to be written as a mix of ARM

and Thumb instruction sets.

• Why using ARM/Thumb Interworking?
– Better code density using Thumb.

– Certain ARM instructions have better performance over
Thumb ones.

– ARM instructions provide some functionality which
Thumb does not.

– Exception handling is required to run under ARM state.

– Thumb program needs state changes from default ARM
state
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About ARM/THUMB Interworking

• System starts in ARM state after reset.

• ARM/Thumb Interworking Veneer
– A small section of code which performs instructions set

change. It’s added by linker when a state change is
detected.

– ARM architecture v5T provides method to change
processor state without using extra instructions.

• Use ARM compiler armcc to compile ARM code.
Use Thumb compiler tcc to compile Thumb code.
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ARM/Thumb interworking Example

• ARM/Thumb Interworking in C/C++ only.
– Profiling

• ARM/Thumb Interworking in ASM only.
– No veneer

– With veneer

• ARM/Thumb Interworking between C/C++ and
ASM.
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ARM/Thumb Interworking in only C/C++

• This program consist of 2 parts
– Armmain.c for main function using ARM instructions

set.
• Print strings

• Call Thumb function

• Compiled using ARM C/C++ compiler.

– Thumbsub.c for sub function called by main function
using Thumb instructions set.

• Print strings

• Return to main function

• Compiled using Thumb C/C++ compiler.



6/42

A
R

M
/T

hum
b Interw

orking
In

stitu
te o

f E
lectro

n
ics, N

ational C
hiao T

ung U
niversity

ARM/Thumb Interworking using C/C++

• Armmain.c

# i n c l u d e  < s t d i o . h >

e x t e r n  v o i d  t h u m b _ f u n c t i o n ( v o i d ) ;

i n t m a i n ( v o i d )
{
     p r i n t f ( " H e l l o  f r o m  A R M \ n " ) ;  
     t h u m b _ f u n c t i o n ( ) ;  
     p r i n t f ( " A n d  g o o d b y e  f r o m  A R M \ n " ) ;  
     r e t u r n  ( 0 ) ;  
}

• Thumbsub.c

# i n c l u d e  < s t d i o . h >

v o i d  t h u m b _ f u n c t i o n ( v o i d )
{
    p r i n t f ( " H e l l o  a n d  g o o d b y e  f r o m  

T h u m b \ n " ) ;
}
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ARM/Thumb Interworking using C/C++

• Building under MS-DOS command line:
– armcc -c -g -O1 -apcs /interwork armmain.c

• -c stands for compile.

• -g generate debug information.

• -O1 compile with median optimization.

– tcc   -c -g -O1 -apcs /interwork thumbsub.c

– armlink armmain.o thumbsub.o -o armtothumb.axf -info
veneers -info totals -callgraph -list Ex1.log

• -o specify output image name

• -info veneer print out veneer information on screen.

• -info totals print out memory size information on screen.

• -callgraph creates static callgraph of functions in an HTML file.

• -list XXX.log redirects information to print in a text file.
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ARM/Thumb Interworking using C/C++

• Building under CodeWarriorIDE:
– 1. Start CodeWarriorIDE.

– 2. File>New to create a new project.
• 2.1 Select Thumb ARM Interworking Image under the Poject tab.

• 2.2 Type the project name, Ex1 for example.

• 2.3 Specify the project path.
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ARM/Thumb Interworking using C/C++

• Building under CodeWarriorIDE (continued):
– 3. Project>Add Files... to add files to the project.

– Please Armmain.c & Thumbsub.c from ARM/ADSv1_1/Examples/Interworking to Ex1
directory first.

• 3.1 Add Armmain.c for ARM related target.(ARMDebug,
ARMRelease, ARMDebRel)

• 3.2 Add Thumbsub.c for Thumb related target.(ThumbDebug,
ThumbRelease, ThumbDebRel)
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ARM/Thumb Interworking using C/C++

• Building under CodeWarrior (continued):
– 4. After adding files to the project, a Project Management

Window would appear.
• 4.1 Hit Build Target Setting button.

• 4.2 A ThumbDebRel Setting window appears. Click Language
Settings>ARM Assembler in Target Setting Panel.
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ARM/Thumb Interworking using C/C++

• Building under CodeWarrior (continued):
• 4.3 Click ATPCS tab. And set as follow:

– Check ARM/Thumb Interworking in ARM/Thumb Procedure Call
Standard Options.

– A line “ -apcs /interwork” would be added to Equivalent
Command line automatically.
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ARM/Thumb Interworking using C/C++

• Building under CodeWarrior (continued):
• 4.4 Repeat Step 4.1~4.2 for the rest of the compilers.

– For Thumb ARM Interworking Project, Arm Thumb Interworking check box in
ATPCS is automatically checked.
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ARM/Thumb Interworking using C/C++

• Building under CodeWarriorIDE (continued):
– 5. Hit the Make button to compile and link the project.

• 5.1 A compiling and linking status window would appear to indicate
making progress.

• 5.2 After finishing compiling and linking, a result message windows
would appear. Check for errors and warnings.
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ARM/Thumb Interworking using C/C++

• Building under CodeWarriorIDE (continued):
– 6. Hit the Run button to run the program.

• 6.1 This would execute AXD to run the program. The image would
be automatic loaded.
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ARM/Thumb Interworking using C/C++

• Running Using AXD
– 1. File>Load Image to load image file.

• Load image file Ex1.axf in directory Ex1/Ex1_data/ThumbDebRel.
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ARM/Thumb Interworking using C/C++

• Running Using AXD (continued):
– 2. Hit the Reload button in AXD to reload the image.

– 3. Hit the Go button in AXD to run the image.
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ARM/Thumb Interworking using C/C++

• Running Using AXD (continued):
– 4. Hit the Show Processor Register button in AXD to show

the contents of the processor’s register.

cpsr = nzcvqIFt
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ARM/Thumb Interworking using C/C++

• Running Using AXD (continued):
– 4. Hit the following buttons to step through the program.

Step into the next instruction.

Step the next instruction.

Complete the current function and return to the caller.

Run to the cursor posistion.
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ARM/Thumb Interworking using C/C++

• About Profiling:
– Profiler samples the program counter and computes the

percentage time of each function spent.

– Flat Profiling: If only pc-sampling info.is present. It can
only display the time percentage spent in each function
excluding the time in its children.

– Callgraph Profiling: If function call count info. Is present.
It can show the approximations of the time spent in
each function including the time in its children.

• Limitations:
– Profiling is NOT available for code in ROM, or for

scatterloaded images.

– No data is gathered for programs that are too small.



20/42

A
R

M
/T

hum
b Interw

orking
In

stitu
te o

f E
lectro

n
ics, N

ational C
hiao T

ung U
niversity

ARM/Thumb Interworking using C/C++

• How to do Profiling:
– 1. In AXD, check Profile in the Load Image window.

– 2. Before running, Options>Profile>Toggle Profile.

– 3. Run the image.

– 4. After running, Options>Profile>Write to file.

– 5. After writing profile data file Ex1.prf , type armprof
Ex1.prf under command-line.

– 6. The profile information would then be interpreted.
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ARM/Thumb Interworking using C/C++

• The t bit in the CPSR (1st bit) would change to
indicate which instruction set is being use.

• The linker provided in ADS adds ARM/Thumb
Interworking Veneers when it detects
ARM/Thumb state change.
– Veneer: A small section of code which performs

instructions set change. It’s added by linker when a
state change is detected.
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ARM/Thumb Interworking in ASM

• This program do computations among registers.
No veneer is needed, inteworking instruction
change is implemented manually.

• The program consists of 4 parts:
– main: Generate branch address, and set bit0=1 to

arrive at target in Thumb mode. Initial in ARM state.

– ThumbProg: Set values for r2, r3. Sum r2,r3 to r2.
Executed in Thumb state.

– ArmProg: Set values for r4, r5. Sum r4, r5 to r4.
Executed in ARM state.

– Stop: Terminate the program.
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ARM/Thumb Interworking in ASM

• Addreg.s source code:
A R E A  A d d R e g , C O D E ,R E A D O N L Y  ; N a m e  t h i s  b l o c k  o f  c o d e .

E N T R Y  ; M a r k  f i r s t  i n s t r u c t i o n  t o  c a l l .
m a in

A D R  r 0 ,T h u m b P r o g  + 1  ; G e n e r a t e  b r a n c h  t a r g e t  a d d r e s s
; a n d  s e t  b i t  0 , h e n c e  a r r i v e

; a t  t a r g e t  i n  T h u m b  s t a t e .
B X  r 0  ; B r a n c h  e x c h a n g e  t o  T h u m b P r o g .

C O D E 1 6  ; S u b s e q u e n t  i n s t r u c t i o n s  a r e  T h u m b  c o d e .
T h u m b P r o g

M O V  r 2 , # 2  ; L o a d  r 2  w i t h  v a l u e  2 .
M O V  r 3 , # 3  ; L o a d  r 3  w i t h  v a l u e  3 .

A D D  r 2 , r 2 , r 3  ; r 2  = r 2  + r 3
A D R  r 0 ,A R M P r o g

B X  r 0
C O D E 3 2  ; S u b s e q u e n t  i n s t r u c t i o n s  a r e  A R M  c o d e .

A R M P r o g
M O V  r 4 , # 4

M O V  r 5 , # 5
A D D  r 4 , r 4 , r 5

s t o p  M O V  r 0 , # 0 x 1 8  ; a n g e l _ S W I r e a s o n _ R e p o r t E x c e p t i o n
L D R  r 1 , = 0 x 2 0 0 2 6  ; A D P _ S t o p p e d _ A p p l i c a t i o n E x i t

S W I  0 x 1 2 3 4 5 6  ; A R M  s e m i h o s t i n g  S W I
E N D  ; M a r k  e n d  o f  t h i s  f i l e .
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ARM/Thumb Interworking in ASM

• Building under command line:
– armasm -g addreg.s

– armlink addreg.o -o addreg

• Executing using ARM-synbolic-debugger under
command line:
– armsd addreg

– Type help for help info. Type quit to quit armsd.

– Type step to step through the program

– Type reg after each instruction execution to display
registers.

– CPSR changes from “t” to “T” entering to Thumb state.
• t: ARM state; T: Thumb state.
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ARM/Thumb Interworking in ASM
-using veneer

• This program sets the values for r0, r1, r2.
Interworking option is added while linking.
Veneers are added by linker.

• The program consist of 2 files.
– Arm.s: Sets the values for r0, r2. Calls for ThumbProg.

Executed in ARM state.

– Thumb.s: Sets the value for r1. Return back to ArmProg.
Executed in Thumb state.
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ARM/Thumb Interworking in ASM
-using Veneer

• Arm.s
A R E A  A r m , C O D E , R E A D O N L Y  ;N a m e  t h i s  b l o c k  o f  c o d e .

I M P O R T  T h u m b P r o g
E N T R Y  ; M a r k  1 s t  i n s t r u c t i o n  t o  c a l l .

A R M P r o g
M O V  r 0 , # 1  ; S e t  r 0  t o  s h o w  i n  A R M  c o d e .

B L  T h u m b P r o g  ; C a l l  T h u m b  s u b r o u t i n e .
M O V  r 2 , # 3  ; S e t  r 2  t o  s h o w  r e t u r n e d  t o  A R M .

; T e r m i n a t e  e x e c u t i o n .
M O V  r 0 , # 0 x 1 8  ; a n g e l _ S W I r e a s o n _ R e p o r t E x c e p t i o n

L D R  r 1 , = 0 x 2 0 0 2 6  ; A D P _ S t o p p e d _ A p p l i c a t i o n E x i t
S W I  0 x 1 2 3 4 5 6  ; A R M  s e m i h o s t i n g  S W I

E N D

A R E A  T h u m b , C O D E ,R E A D O N L Y ; N a m e  t h i s  b l o c k  o f  c o d e .

C O D E 1 6  ; S u b s e q u e n t  i n s t r u c t i o n s  a r e  T h u m b .
E X P O R T  T h u m b P r o g

T h u m b P r o g
M O V  r 1 , # 2  ; S e t  r 1  t o  s h o w  r e a c h e d  T h u m b  c o d e .

B X  lr  ; R e t u r n  t o  A R M  s u b r o u t i n e .
E N D  ; M a r k  e n d  o f  t h i s  f i l e .

• Thumb.s
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ARM/Thumb Interworking in ASM
-using Veneer

• Building under command line:
– armasm arm.s

– armasm -16 -apcs /interwork thumb.s

– armlink arm.o thumb.o -o count
• The callee must be compiled with interworking option if it is

implemented in a defferent state from the caller.

• Running under command line:
– Type armsd count.

– Type list 0x8000 to list the linked code.

– Observe that $Ven$AT$$ThumbProg is added to the
code. This is the veneer added by the linker.
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ARM/Thumb Interworking in ASM
-using Veneer

• Linked Code:
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ARM/Thumb Interworking between
C/C++ & ASM using veneer

• General rules:
– If the callee routine is in C, the caller should use the BL instruction to

make a call , compile it using -apcs /interwork.

– If the callee routine is in assembly language, assemble it with the -apcs
/interwork option. and return using BX lr.



30/42

A
R

M
/T

hum
b Interw

orking
In

stitu
te o

f E
lectro

n
ics, N

ational C
hiao T

ung U
niversity

ARM/Thumb Interworking between
C/C++ & ASM using veneer

• This program calls the ARM function with a
parameter.  The ARM function returns that
parameter with 4 added.

• The program is consisted of 2 files:
– thumb.c: The main function. Calls for ARM function with

a parameter i. It’s implemented in Thumb state using
C/C++.

– Arm.s: Add 4 to the parameter and returns. Called by
Thumb main function. Implemented in ARM state using
ASM.
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ARM/Thumb Interworking between
C/C++ & ASM using veneer

• thumb.c
# i n c l u d e  < s t d i o . h >
e x t e r n  i n t a r m _ f u n c t i o n (i n t) ;
i n t m a i n ( v o i d )
{

i n t i  = 1 ;
p r i n t f ( " i  = % d  \ n " , i ) ;
p r i n t f ( " A n d  n o w  i  = % d  \ n " , a r m _ f u n c t i o n ( i ) ) ;
r e t u r n  ( 0 ) ;

}

A R E A  A r m , C O D E , R E A D O N L Y ;N a m e  t h i s  b l o c k  o f  c o d e .
E X P O R T  a r m _ f u n c t i o n

a r m _ f u n c t i o n
A D D  r 0 , r 0 , # 4  ; A d d  4  t o  f i r s t  p a r a m e t e r .
B X  L R  ;R e t u r n
E N D

• arm.s



32/42

A
R

M
/T

hum
b Interw

orking
In

stitu
te o

f E
lectro

n
ics, N

ational C
hiao T

ung U
niversity

ARM/Thumb Interworking between
C/C++ & ASM using veneer

• Building under command line:
– tcc -c -apcs /interwork thumb.c

– armasm -apcs /interwork arm.s

– armlink arm.o thumb.o -o add

• Running under command line:
– Type armsd add.

– Type go.

– Type list main to list the linked code for main function.

– Type list arm_function to list the linked code.

– Observe that $Ven$AT$$ThumbProg is added to the
code. This is the veneer added by the linker.



33/42

A
R

M
/T

hum
b Interw

orking
In

stitu
te o

f E
lectro

n
ics, N

ational C
hiao T

ung U
niversity

Lab Exercise

• Part A: Interworking in C/C++
– Thumb Main & ARM Sub

– Profiling

• Part B: Interworking in ASM
– No veneer

– Using veneer

• Part C: Interworking in C/C++ and ASM
– Modify the last example
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Lab Exercise - Part A

• Write a program in C/C++. The main function is
implemented in Thumb instructions set. The
called function is implemented in ARM state.

• Specifications:
– Thumbmain: Prints “Hello from thumb main!” &

“Goodbye from Thumb main!!”. Calls ARM function.
Implemented in Thumb instructions set.

– Armsub: Prints “Hello from ARM sub.”. Return back to
main. Implemented in ARM instruction set.

– Show the veneers in the linked code and its info.

– Observe how the t-bit in CPSR changes.
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Lab Exercise - Part A

• Specification:
– Load the image with profiling option checked.

• Use callgraph profiling.

– Toggle profiling and run the program.

– Save the profiling data to file a.prf

– Execute armprof  a.prf to see the profiling information.
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Lab Exercise - Part B

• Write a program in ASM which swaps the value of
[r1,r2], [r3,r4] , no linker added veneers should be
added.

• Specifications:
– Swap function is implemented in ARM instructions.

– Main Program is implemented in Thumb instructions.

– Manually change the instruction set using, no linker
added veneer.

– Observe the linked code and the registers.

• Using veneer:
– Do the above exercise using linker added veneer.

– Show the veneers added.
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Lab Exercise - Part B

• Hints:
– ARM is in ARM state at the beginning. A change to

Thumb state is needed.

– ARMASM doesn’t include ARM-to-Thumb header
automatically as ARMCC does. You must manually
change the state to thumb at initial.

– Veneers are added when there’s a ARM/THUMB or
THUMB/ARM procedure call.
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Lab Exercise - Part C

• Modify the last example (interworking between
C/C++ and ASM using veneer). Such that the
main is implemented in ASM, the function is
implemented in C.

• Specifications:
– Main: Implement in ASM  using Thumb instructions.

Call the subroutine with a parameter.

– Sub: Implement in C/C++ using ARM instructions. Add
4 to the parameter passed from main and return.

– Show the linked code.

– Observe the register.
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Lab Exercise - Part C

• Hints:
– C functions called by ASM code must have a return

value.

– 1st parameter and function return value use R0 to pass
value.

– 2nd to 4th parameters use R1 to R3 to pass value.

– 5th and more parameters should use stack to pass
value.

– Standard I/O in C function does not work (which means
you cannot us printf() in the C function called by ASM
main).
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Reference Topics & Related Documents

• Overview of ARM architecture [ADS_AssemblerGuide 2.2]

• ARM instruction reference [ADS_AssemblerGuide 4] [QRC_Armside]
• Thumb instruction reference [ADS_AssemblerGuide 5]

[QRC_Thumbside]

• Interworking with ARM & Thumb  [ADS_DeveloperGuide 2.8, 3]
• About ARM-Thumb Procedure Call Standard (ATPCS)

[ADS_DeveloperGuide 2.1] [ATPCS spec]

• AXD,armsd   [ADS_DebuggerGuide]
• Profiling [ADS_DebuggerGuide 4.7] [ADS_CompilerLinkerUtil 6.4]

• Mixing C,C++,ASM   [ADS_DeveloperGuide 4]


